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1.  Copyright Notice
© Copyright 2024 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BV. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BV does not warrant, guarantee or make any representations regarding
the use, or the results of the use of the software or the information contained herein. Esko Software
BV shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use
or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in
any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means
without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE
®

 Colors displayed in the software application or in the user documentation may not match
PANTONE-identified standards. Consult current PANTONE Color Publications for accurate color.
PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute
for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be
copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

3
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JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle
corporation in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Oce.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by GlobalVision. ArtProof and ScanProof are registered
trademarks of GlobalVision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Raymonde de Larochelaan 13

B – 9051 Gent

info.eur@esko.com

1.1.  Third Party Licensing

This product includes lzw-ab.

    Copyright (c) David Bryant
    All rights reserved.

    Redistribution and use in source and binary forms, with or without
    modification, are permitted provided that the following conditions are met:

    * Redistributions of source code must retain the above copyright notice,
      this list of conditions and the following disclaimer.
    * Redistributions in binary form must reproduce the above copyright notice,
      this list of conditions and the following disclaimer in the
      documentation and/or other materials provided with the distribution.
    * Neither the name of Conifer Software nor the names of its contributors
      may be used to endorse or promote products derived from this software
      without specific prior written permission.

    THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
    AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
    IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
    ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR
    ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
    DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
    SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
    CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
    OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
    OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes ICC Profiles.
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    Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm
    ColourKit Profiler Suite (www.colourprofiling.com)
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol(R) and
    SWOP(R) are all registered trademarks of IDEAlliance(C).
    
------------------------------------------------------------

This product includes PANTONE Color Libraries.

    PANTONE® and other Pantone trademarks are the property of Pantone LLC.
    Pantone is a wholly owned subsidiary of X-Rite, Incorporated.
    
------------------------------------------------------------

This product includes curl.

   COPYRIGHT AND PERMISSION NOTICE

   Copyright (c) 1996 - 2023, Daniel Stenberg, <daniel@haxx.se>, and many
   contributors, see the THANKS file.

   All rights reserved.

   Permission to use, copy, modify, and distribute this software for any purpose
   with or without fee is hereby granted, provided that the above copyright
   notice and this permission notice appear in all copies.

   THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
   IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
   FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN
   NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
   DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
   OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
   OR OTHER DEALINGS IN THE SOFTWARE.

   Except as contained in this notice, the name of a copyright holder shall not
   be used in advertising or otherwise to promote the sale, use or other dealings
   in this Software without prior written authorization of the copyright holder.
    
------------------------------------------------------------

This product includes LibTIFF.

      Copyright (c) 1988-1997 Sam Leffler
      Copyright (c) 1991-1997 Silicon Graphics, Inc.

      Permission to use, copy, modify, distribute, and sell this software and
      its documentation for any purpose is hereby granted without fee, provided
      that (i) the above copyright notices and this permission notice appear in
      all copies of the software and related documentation, and (ii) the names of
      Sam Leffler and Silicon Graphics may not be used in any advertising or
      publicity relating to the software without the specific, prior written
      permission of Sam Leffler and Silicon Graphics.

      THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
      EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
      WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

      IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
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      ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
      OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
      WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
      LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
      OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes FreeType.

    Portions of this software are copyright (C) 2014 The FreeType
    Project (www.freetype.org) licensed under the Freetype License.
    All rights reserved.
    
------------------------------------------------------------

This product includes ICU.

      Copyright (c) 1991-2023 Unicode, Inc. All rights reserved.
      Distributed under the Terms of Use in https://www.unicode.org/copyright.html.
      
      Permission is hereby granted, free of charge, to any person obtaining
      a copy of the Unicode data files and any associated documentation
      (the "Data Files") or Unicode software and any associated documentation
      (the "Software") to deal in the Data Files or Software
      without restriction, including without limitation the rights to use,
      copy, modify, merge, publish, distribute, and/or sell copies of
      the Data Files or Software, and to permit persons to whom the Data Files
      or Software are furnished to do so, provided that either
      (a) this copyright and permission notice appear with all copies
      of the Data Files or Software, or
      (b) this copyright and permission notice appear in associated
      Documentation.
      
      THE DATA FILES AND SOFTWARE ARE PROVIDED "AS IS", WITHOUT WARRANTY OF
      ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE
      WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
      NONINFRINGEMENT OF THIRD PARTY RIGHTS.
      IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS
      NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL
      DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE,
      DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER
      TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
      PERFORMANCE OF THE DATA FILES OR SOFTWARE.

      ----------------------------------------------------------------------

      Chinese/Japanese Word Break Dictionary Data (cjdict.txt)
      
       #     The Google Chrome software developed by Google is licensed under
       # the BSD license. Other software included in this distribution is
       # provided under other licenses, as set forth below.
       #
       #  The BSD License
       #  http://opensource.org/licenses/bsd-license.php
       #  Copyright (C) 2006-2008, Google Inc.
       #
       #  All rights reserved.
       #
       #  Redistribution and use in source and binary forms, with or without
       # modification, are permitted provided that the following conditions are met:
       #
       #  Redistributions of source code must retain the above copyright notice,
       # this list of conditions and the following disclaimer.
       #  Redistributions in binary form must reproduce the above
       # copyright notice, this list of conditions and the following
       # disclaimer in the documentation and/or other materials provided with
       # the distribution.
       #  Neither the name of  Google Inc. nor the names of its
       # contributors may be used to endorse or promote products derived from
       # this software without specific prior written permission.
       #
       #
       #  THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
       # CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
       # INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
       # MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
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       # DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
       # LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
       # CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
       # SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
       # BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
       # LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
       # NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
       # SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
       #
       #
       #  The word list in cjdict.txt are generated by combining three word lists
       # listed below with further processing for compound word breaking. The
       # frequency is generated with an iterative training against Google web
       # corpora.
       #
       #  * Libtabe (Chinese)
       #    - https://sourceforge.net/project/?group_id=1519
       #    - Its license terms and conditions are shown below.
       #
       #  * IPADIC (Japanese)
       #    - http://chasen.aist-nara.ac.jp/chasen/distribution.html
       #    - Its license terms and conditions are shown below.
       #
       #  ---------COPYING.libtabe ---- BEGIN--------------------
       #
       #  /*
       #   * Copyright (c) 1999 TaBE Project.
       #   * Copyright (c) 1999 Pai-Hsiang Hsiao.
       #   * All rights reserved.
       #   *
       #   * Redistribution and use in source and binary forms, with or without
       #   * modification, are permitted provided that the following conditions
       #   * are met:
       #   *
       #   * . Redistributions of source code must retain the above copyright
       #   *   notice, this list of conditions and the following disclaimer.
       #   * . Redistributions in binary form must reproduce the above copyright
       #   *   notice, this list of conditions and the following disclaimer in
       #   *   the documentation and/or other materials provided with the
       #   *   distribution.
       #   * . Neither the name of the TaBE Project nor the names of its
       #   *   contributors may be used to endorse or promote products derived
       #   *   from this software without specific prior written permission.
       #   *
       #   * THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
       #   * "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
       #   * LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
       #   * FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
       #   * REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
       #   * INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
       #   * (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
       #   * SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
       #   * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
       #   * STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
       #   * ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
       #   * OF THE POSSIBILITY OF SUCH DAMAGE.
       #   */
       #
       #  /*
       #   * Copyright (c) 1999 Computer Systems and Communication Lab,
       #   *                    Institute of Information Science, Academia
       #       *                    Sinica. All rights reserved.
       #   *
       #   * Redistribution and use in source and binary forms, with or without
       #   * modification, are permitted provided that the following conditions
       #   * are met:
       #   *
       #   * . Redistributions of source code must retain the above copyright
       #   *   notice, this list of conditions and the following disclaimer.
       #   * . Redistributions in binary form must reproduce the above copyright
       #   *   notice, this list of conditions and the following disclaimer in
       #   *   the documentation and/or other materials provided with the
       #   *   distribution.
       #   * . Neither the name of the Computer Systems and Communication Lab
       #   *   nor the names of its contributors may be used to endorse or
       #   *   promote products derived from this software without specific
       #   *   prior written permission.
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       #   *
       #   * THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
       #   * "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
       #   * LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
       #   * FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
       #   * REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
       #   * INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
       #   * (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
       #   * SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
       #   * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
       #   * STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
       #   * ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
       #   * OF THE POSSIBILITY OF SUCH DAMAGE.
       #   */
       #
       #  Copyright 1996 Chih-Hao Tsai @ Beckman Institute,
       #      University of Illinois
       #  c-tsai4@uiuc.edu  http://casper.beckman.uiuc.edu/~c-tsai4
       #
       #  ---------------COPYING.libtabe-----END--------------------------------
       #
       #
       #  ---------------COPYING.ipadic-----BEGIN-------------------------------
       #
       #  Copyright 2000, 2001, 2002, 2003 Nara Institute of Science
       #  and Technology.  All Rights Reserved.
       #
       #  Use, reproduction, and distribution of this software is permitted.
       #  Any copy of this software, whether in its original form or modified,
       #  must include both the above copyright notice and the following
       #  paragraphs.
       #
       #  Nara Institute of Science and Technology (NAIST),
       #  the copyright holders, disclaims all warranties with regard to this
       #  software, including all implied warranties of merchantability and
       #  fitness, in no event shall NAIST be liable for
       #  any special, indirect or consequential damages or any damages
       #  whatsoever resulting from loss of use, data or profits, whether in an
       #  action of contract, negligence or other tortuous action, arising out
       #  of or in connection with the use or performance of this software.
       #
       #  A large portion of the dictionary entries
       #  originate from ICOT Free Software.  The following conditions for ICOT
       #  Free Software applies to the current dictionary as well.
       #
       #  Each User may also freely distribute the Program, whether in its
       #  original form or modified, to any third party or parties, PROVIDED
       #  that the provisions of Section 3 ("NO WARRANTY") will ALWAYS appear
       #  on, or be attached to, the Program, which is distributed substantially
       #  in the same form as set out herein and that such intended
       #  distribution, if actually made, will neither violate or otherwise
       #  contravene any of the laws and regulations of the countries having
       #  jurisdiction over the User or the intended distribution itself.
       #
       #  NO WARRANTY
       #
       #  The program was produced on an experimental basis in the course of the
       #  research and development conducted during the project and is provided
       #  to users as so produced on an experimental basis.  Accordingly, the
       #  program is provided without any warranty whatsoever, whether express,
       #  implied, statutory or otherwise.  The term "warranty" used herein
       #  includes, but is not limited to, any warranty of the quality,
       #  performance, merchantability and fitness for a particular purpose of
       #  the program and the nonexistence of any infringement or violation of
       #  any right of any third party.
       #
       #  Each user of the program will agree and understand, and be deemed to
       #  have agreed and understood, that there is no warranty whatsoever for
       #  the program and, accordingly, the entire risk arising from or
       #  otherwise connected with the program is assumed by the user.
       #
       #  Therefore, neither ICOT, the copyright holder, or any other
       #  organization that participated in or was otherwise related to the
       #  development of the program and their respective officials, directors,
       #  officers and other employees shall be held liable for any and all
       #  damages, including, without limitation, general, special, incidental
       #  and consequential damages, arising out of or otherwise in connection
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       #  with the use or inability to use the program or any product, material
       #  or result produced or otherwise obtained by using the program,
       #  regardless of whether they have been advised of, or otherwise had
       #  knowledge of, the possibility of such damages at any time during the
       #  project or thereafter.  Each user will be deemed to have agreed to the
       #  foregoing by his or her commencement of use of the program.  The term
       #  "use" as used herein includes, but is not limited to, the use,
       #  modification, copying and distribution of the program and the
       #  production of secondary products from the program.
       #
       #  In the case where the program, whether in its original form or
       #  modified, was distributed or delivered to or received by a user from
       #  any person, organization or entity other than ICOT, unless it makes or
       #  grants independently of ICOT any specific warranty to the user in
       #  writing, such person, organization or entity, will also be exempted
       #  from and not be held liable to the user for any such damages as noted
       #  above as far as the program is concerned.
       #
       #  ---------------COPYING.ipadic-----END----------------------------------
      
      ----------------------------------------------------------------------
      
      Lao Word Break Dictionary Data (laodict.txt)
      
       # Copyright (C) 2016 and later: Unicode, Inc. and others.
       # License & terms of use: http://www.unicode.org/copyright.html
       # Copyright (c) 2015 International Business Machines Corporation
       # and others. All Rights Reserved.
       #
       # Project: https://github.com/rober42539/lao-dictionary
       # Dictionary: https://github.com/rober42539/lao-dictionary/laodict.txt
       # License: https://github.com/rober42539/lao-dictionary/LICENSE.txt
       #          (copied below)
       #
       # This file is derived from the above dictionary version of Nov 22, 2020
       #  ----------------------------------------------------------------------
       #  Copyright (C) 2013 Brian Eugene Wilson, Robert Martin Campbell.
       #  All rights reserved.
       #
       #  Redistribution and use in source and binary forms, with or without
       #  modification, are permitted provided that the following conditions are met:
       #
       #  Redistributions of source code must retain the above copyright notice, this
       #  list of conditions and the following disclaimer. Redistributions in binary
       #  form must reproduce the above copyright notice, this list of conditions and
       #  the following disclaimer in the documentation and/or other materials
       #  provided with the distribution.
       #
       # THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
       # "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
       # LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
       # FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
       # COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
       # INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
       # (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
       # SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
       # HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
       # STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
       # ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
       # OF THE POSSIBILITY OF SUCH DAMAGE.
       #  --------------------------------------------------------------------------
      
      ----------------------------------------------------------------------
      
      Burmese Word Break Dictionary Data (burmesedict.txt)
      
       #  Copyright (c) 2014 International Business Machines Corporation
       #  and others. All Rights Reserved.
       #
       #  This list is part of a project hosted at:
       #    github.com/kanyawtech/myanmar-karen-word-lists
       #
       #  --------------------------------------------------------------------------
       #  Copyright (c) 2013, LeRoy Benjamin Sharon
       #  All rights reserved.
       #
       #  Redistribution and use in source and binary forms, with or without
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       #  modification, are permitted provided that the following conditions
       #  are met: Redistributions of source code must retain the above
       #  copyright notice, this list of conditions and the following
       #  disclaimer.  Redistributions in binary form must reproduce the
       #  above copyright notice, this list of conditions and the following
       #  disclaimer in the documentation and/or other materials provided
       #  with the distribution.
       #
       #    Neither the name Myanmar Karen Word Lists, nor the names of its
       #    contributors may be used to endorse or promote products derived
       #    from this software without specific prior written permission.
       #
       #  THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
       #  CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
       #  INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
       #  MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
       #  DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS
       #  BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
       #  EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
       #  TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
       #  DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
       #  ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
       #  TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
       #  THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
       #  SUCH DAMAGE.
       #  --------------------------------------------------------------------------
      
      ----------------------------------------------------------------------
      
      Time Zone Database
      
        ICU uses the public domain data and code derived from Time Zone
      Database for its time zone support. The ownership of the TZ database
      is explained in BCP 175: Procedure for Maintaining the Time Zone
      Database section 7.
      
       # 7.  Database Ownership
       #
       #    The TZ database itself is not an IETF Contribution or an IETF
       #    document.  Rather it is a pre-existing and regularly updated work
       #    that is in the public domain, and is intended to remain in the
       #    public domain.  Therefore, BCPs 78 [RFC5378] and 79 [RFC3979] do
       #    not apply to the TZ Database or contributions that individuals make
       #    to it.  Should any claims be made and substantiated against the TZ
       #    Database, the organization that is providing the IANA
       #    Considerations defined in this RFC, under the memorandum of
       #    understanding with the IETF, currently ICANN, may act in accordance
       #    with all competent court orders.  No ownership claims will be made
       #    by ICANN or the IETF Trust on the database or the code.  Any person
       #    making a contribution to the database or code waives all rights to
       #    future claims in that contribution or in the TZ Database.
      
      ----------------------------------------------------------------------
      
      Google double-conversion
      
      Copyright 2006-2011, the V8 project authors. All rights reserved.
      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions are
      met:
      
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above
            copyright notice, this list of conditions and the following
            disclaimer in the documentation and/or other materials provided
            with the distribution.
          * Neither the name of Google Inc. nor the names of its
            contributors may be used to endorse or promote products derived
            from this software without specific prior written permission.
      
      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
      "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
      LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
      A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
      OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
      SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
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      LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
      DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
      THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
      (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
      OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
      
      ----------------------------------------------------------------------
      
      File: aclocal.m4 (only for ICU4C)
      Section: pkg.m4 - Macros to locate and utilise pkg-config.
      
      
      Copyright (c) 2004 Scott James Remnant <scott@netsplit.com>.
      Copyright (c) 2012-2015 Dan Nicholson <dbn.lists@gmail.com>
      
      This program is free software; you can redistribute it and/or modify
      it under the terms of the GNU General Public License as published by
      the Free Software Foundation; either version 2 of the License, or
      (at your option) any later version.
      
      This program is distributed in the hope that it will be useful, but
      WITHOUT ANY WARRANTY; without even the implied warranty of
      MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU
      General Public License for more details.
      
      You should have received a copy of the GNU General Public License
      along with this program; if not, write to the Free Software
      Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA
      02111-1307, USA.
      
      As a special exception to the GNU General Public License, if you
      distribute this file as part of a program that contains a
      configuration script generated by Autoconf, you may include it under
      the same distribution terms that you use for the rest of that
      program.
      
      
      (The condition for the exception is fulfilled because
      ICU4C includes a configuration script generated by Autoconf,
      namely the `configure` script.)
      
      ----------------------------------------------------------------------
      
      File: config.guess (only for ICU4C)
      
      
      This file is free software; you can redistribute it and/or modify it
      under the terms of the GNU General Public License as published by
      the Free Software Foundation; either version 3 of the License, or
      (at your option) any later version.
      
      This program is distributed in the hope that it will be useful, but
      WITHOUT ANY WARRANTY; without even the implied warranty of
      MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the GNU
      General Public License for more details.
      
      You should have received a copy of the GNU General Public License
      along with this program; if not, see <https://www.gnu.org/licenses/>.
      
      As a special exception to the GNU General Public License, if you
      distribute this file as part of a program that contains a
      configuration script generated by Autoconf, you may include it under
      the same distribution terms that you use for the rest of that
      program.  This Exception is an additional permission under section 7
      of the GNU General Public License, version 3 ("GPLv3").
      
      
      (The condition for the exception is fulfilled because
      ICU4C includes a configuration script generated by Autoconf,
      namely the `configure` script.)
      
      ----------------------------------------------------------------------
      
      File: install-sh (only for ICU4C)
      
      
      Copyright 1991 by the Massachusetts Institute of Technology
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      Permission to use, copy, modify, distribute, and sell this software and its
      documentation for any purpose is hereby granted without fee, provided that
      the above copyright notice appear in all copies and that both that
      copyright notice and this permission notice appear in supporting
      documentation, and that the name of M.I.T. not be used in advertising or
      publicity pertaining to distribution of the software without specific,
      written prior permission.  M.I.T. makes no representations about the
      suitability of this software for any purpose.  It is provided "as is"
      without express or implied warranty.
    
------------------------------------------------------------

This product includes JBIG2Lib.

    Portions of this product copyrights (C) 2002 Glyph & Cog, LLC.
    
------------------------------------------------------------

This product includes JPEGLib.
This software is copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding.
      All Rights Reserved.
      
      This software is based in part on the work of the Independent JPEG Group.
------------------------------------------------------------

This product includes Little CMS.

    Little CMS
    Copyright (c) 1998-2020 Marti Maria Saguer

    Permission is hereby granted, free of charge, to any person obtaining
    a copy of this software and associated documentation files (the 
    "Software"), to deal in the Software without restriction, including
    without limitation the rights to use, copy, modify, merge, publish,
    distribute, sublicense, and/or sell copies of the Software, and to 
    permit persons to whom the Software is furnished to do so, subject
    to the following conditions:

    The above copyright notice and this permission notice shall be 
    included in all copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
    EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
    MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
    IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
    CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
    TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE 
    SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
    
------------------------------------------------------------

This product includes libxml2.

    Copyright (C) 1998-2012 Daniel Veillard.  All Rights Reserved.

    Permission is hereby granted, free of charge, to any person obtaining a copy
    of this software and associated documentation files (the "Software"), to deal
    in the Software without restriction, including without limitation the rights
    to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
    copies of the Software, and to permit persons to whom the Software is fur-
    nished to do so, subject to the following conditions:

    The above copyright notice and this permission notice shall be included in
    all copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
    IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
    NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE
    AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
    LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
    OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
    THE SOFTWARE.
    
------------------------------------------------------------

This product includes OpenJDK.
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The GNU General Public License (GPL)

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies of this license
document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share
and change it.  By contrast, the GNU General Public License is intended to
guarantee your freedom to share and change free software--to make sure the
software is free for all its users.  This General Public License applies to
most of the Free Software Foundation's software and to any other program whose
authors commit to using it.  (Some other Free Software Foundation software is
covered by the GNU Library General Public License instead.) You can apply it to
your programs, too.

When we speak of free software, we are referring to freedom, not price.  Our
General Public Licenses are designed to make sure that you have the freedom to
distribute copies of free software (and charge for this service if you wish),
that you receive source code or can get it if you want it, that you can change
the software or use pieces of it in new free programs; and that you know you
can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny
you these rights or to ask you to surrender the rights.  These restrictions
translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for
a fee, you must give the recipients all the rights that you have.  You must
make sure that they, too, receive or can get the source code.  And you must
show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2)
offer you this license which gives you legal permission to copy, distribute
and/or modify the software.

Also, for each author's protection and ours, we want to make certain that
everyone understands that there is no warranty for this free software.  If the
software is modified by someone else and passed on, we want its recipients to
know that what they have is not the original, so that any problems introduced
by others will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents.  We
wish to avoid the danger that redistributors of a free program will
individually obtain patent licenses, in effect making the program proprietary.
To prevent this, we have made it clear that any patent must be licensed for
everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification
follow.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice
placed by the copyright holder saying it may be distributed under the terms of
this General Public License.  The "Program", below, refers to any such program
or work, and a "work based on the Program" means either the Program or any
derivative work under copyright law: that is to say, a work containing the
Program or a portion of it, either verbatim or with modifications and/or
translated into another language.  (Hereinafter, translation is included
without limitation in the term "modification".) Each licensee is addressed as
"you".

Activities other than copying, distribution and modification are not covered by
this License; they are outside its scope.  The act of running the Program is
not restricted, and the output from the Program is covered only if its contents
constitute a work based on the Program (independent of having been made by
running the Program).  Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as
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you receive it, in any medium, provided that you conspicuously and
appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License
and to the absence of any warranty; and give any other recipients of the
Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may
at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus
forming a work based on the Program, and copy and distribute such modifications
or work under the terms of Section 1 above, provided that you also meet all of
these conditions:

    a) You must cause the modified files to carry prominent notices stating
    that you changed the files and the date of any change.

    b) You must cause any work that you distribute or publish, that in whole or
    in part contains or is derived from the Program or any part thereof, to be
    licensed as a whole at no charge to all third parties under the terms of
    this License.

    c) If the modified program normally reads commands interactively when run,
    you must cause it, when started running for such interactive use in the
    most ordinary way, to print or display an announcement including an
    appropriate copyright notice and a notice that there is no warranty (or
    else, saying that you provide a warranty) and that users may redistribute
    the program under these conditions, and telling the user how to view a copy
    of this License.  (Exception: if the Program itself is interactive but does
    not normally print such an announcement, your work based on the Program is
    not required to print an announcement.)

These requirements apply to the modified work as a whole.  If identifiable
sections of that work are not derived from the Program, and can be reasonably
considered independent and separate works in themselves, then this License, and
its terms, do not apply to those sections when you distribute them as separate
works.  But when you distribute the same sections as part of a whole which is a
work based on the Program, the distribution of the whole must be on the terms
of this License, whose permissions for other licensees extend to the entire
whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your
rights to work written entirely by you; rather, the intent is to exercise the
right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the
Program (or with a work based on the Program) on a volume of a storage or
distribution medium does not bring the other work under the scope of this
License.

3. You may copy and distribute the Program (or a work based on it, under
Section 2) in object code or executable form under the terms of Sections 1 and
2 above provided that you also do one of the following:

    a) Accompany it with the complete corresponding machine-readable source
    code, which must be distributed under the terms of Sections 1 and 2 above
    on a medium customarily used for software interchange; or,

    b) Accompany it with a written offer, valid for at least three years, to
    give any third party, for a charge no more than your cost of physically
    performing source distribution, a complete machine-readable copy of the
    corresponding source code, to be distributed under the terms of Sections 1
    and 2 above on a medium customarily used for software interchange; or,

    c) Accompany it with the information you received as to the offer to
    distribute corresponding source code.  (This alternative is allowed only
    for noncommercial distribution and only if you received the program in
    object code or executable form with such an offer, in accord with
    Subsection b above.)

The source code for a work means the preferred form of the work for making
modifications to it.  For an executable work, complete source code means all
the source code for all modules it contains, plus any associated interface
definition files, plus the scripts used to control compilation and installation
of the executable.  However, as a special exception, the source code
distributed need not include anything that is normally distributed (in either

14



1Curve Pilot PressSync

source or binary form) with the major components (compiler, kernel, and so on)
of the operating system on which the executable runs, unless that component
itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy
from a designated place, then offering equivalent access to copy the source
code from the same place counts as distribution of the source code, even though
third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as
expressly provided under this License.  Any attempt otherwise to copy, modify,
sublicense or distribute the Program is void, and will automatically terminate
your rights under this License.  However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so
long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it.
However, nothing else grants you permission to modify or distribute the Program
or its derivative works.  These actions are prohibited by law if you do not
accept this License.  Therefore, by modifying or distributing the Program (or
any work based on the Program), you indicate your acceptance of this License to
do so, and all its terms and conditions for copying, distributing or modifying
the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program),
the recipient automatically receives a license from the original licensor to
copy, distribute or modify the Program subject to these terms and conditions.
You may not impose any further restrictions on the recipients' exercise of the
rights granted herein.  You are not responsible for enforcing compliance by
third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues), conditions
are imposed on you (whether by court order, agreement or otherwise) that
contradict the conditions of this License, they do not excuse you from the
conditions of this License.  If you cannot distribute so as to satisfy
simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the Program at all.
For example, if a patent license would not permit royalty-free redistribution
of the Program by all those who receive copies directly or indirectly through
you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any
particular circumstance, the balance of the section is intended to apply and
the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or
other property right claims or to contest validity of any such claims; this
section has the sole purpose of protecting the integrity of the free software
distribution system, which is implemented by public license practices.  Many
people have made generous contributions to the wide range of software
distributed through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing to
distribute software through any other system and a licensee cannot impose that
choice.

This section is intended to make thoroughly clear what is believed to be a
consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in certain
countries either by patents or by copyrighted interfaces, the original
copyright holder who places the Program under this License may add an explicit
geographical distribution limitation excluding those countries, so that
distribution is permitted only in or among countries not thus excluded.  In
such case, this License incorporates the limitation as if written in the body
of this License.

9. The Free Software Foundation may publish revised and/or new versions of the
General Public License from time to time.  Such new versions will be similar in
spirit to the present version, but may differ in detail to address new problems
or concerns.

Each version is given a distinguishing version number.  If the Program
specifies a version number of this License which applies to it and "any later
version", you have the option of following the terms and conditions either of
that version or of any later version published by the Free Software Foundation.
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If the Program does not specify a version number of this License, you may
choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs
whose distribution conditions are different, write to the author to ask for
permission.  For software which is copyrighted by the Free Software Foundation,
write to the Free Software Foundation; we sometimes make exceptions for this.
Our decision will be guided by the two goals of preserving the free status of
all derivatives of our free software and of promoting the sharing and reuse of
software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR
THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.  EXCEPT WHEN OTHERWISE
STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE,
YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY
GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA
BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER
OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible
use to the public, the best way to achieve this is to make it free software
which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program.  It is safest to attach
them to the start of each source file to most effectively convey the exclusion
of warranty; and each file should have at least the "copyright" line and a
pointer to where the full notice is found.

    One line to give the program's name and a brief idea of what it does.

    Copyright (C) <year> <name of author>

    This program is free software; you can redistribute it and/or modify it
    under the terms of the GNU General Public License as published by the Free
    Software Foundation; either version 2 of the License, or (at your option)
    any later version.

    This program is distributed in the hope that it will be useful, but WITHOUT
    ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or
    FITNESS FOR A PARTICULAR PURPOSE.  See the GNU General Public License for
    more details.

    You should have received a copy of the GNU General Public License along
    with this program; if not, write to the Free Software Foundation, Inc.,
    51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it
starts in an interactive mode:

    Gnomovision version 69, Copyright (C) year name of author Gnomovision comes
    with ABSOLUTELY NO WARRANTY; for details type 'show w'.  This is free
    software, and you are welcome to redistribute it under certain conditions;
    type 'show c' for details.

The hypothetical commands 'show w' and 'show c' should show the appropriate
parts of the General Public License.  Of course, the commands you use may be
called something other than 'show w' and 'show c'; they could even be
mouse-clicks or menu items--whatever suits your program.
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You should also get your employer (if you work as a programmer) or your school,
if any, to sign a "copyright disclaimer" for the program, if necessary.  Here
is a sample; alter the names:

    Yoyodyne, Inc., hereby disclaims all copyright interest in the program
    'Gnomovision' (which makes passes at compilers) written by James Hacker.

    signature of Ty Coon, 1 April 1989

    Ty Coon, President of Vice

This General Public License does not permit incorporating your program into
proprietary programs.  If your program is a subroutine library, you may
consider it more useful to permit linking proprietary applications with the
library.  If this is what you want to do, use the GNU Library General Public
License instead of this License.

"CLASSPATH" EXCEPTION TO THE GPL

Certain source files distributed by Oracle America and/or its affiliates are
subject to the following clarification and special exception to the GPL, but
only where Oracle has expressly included in the particular source file's header
the words "Oracle designates this particular file as subject to the "Classpath"
exception as provided by Oracle in the LICENSE file that accompanied this code."

    Linking this library statically or dynamically with other modules is making
    a combined work based on this library.  Thus, the terms and conditions of
    the GNU General Public License cover the whole combination.

    As a special exception, the copyright holders of this library give you
    permission to link this library with independent modules to produce an
    executable, regardless of the license terms of these independent modules,
    and to copy and distribute the resulting executable under terms of your
    choice, provided that you also meet, for each linked independent module,
    the terms and conditions of the license of that module.  An independent
    module is a module which is not derived from or based on this library.  If
    you modify this library, you may extend this exception to your version of
    the library, but you are not obligated to do so.  If you do not wish to do
    so, delete this exception statement from your version.
    
------------------------------------------------------------

This product includes OpenJPEG.

        The copyright in this software is being made available under the 2-clauses
        BSD License, included below. This software may be subject to other third
        party and contributor rights, including patent rights, and no such rights
        are granted under this license.
       
        Copyright (c) 2002-2014, Universite catholique de Louvain (UCL), Belgium
        Copyright (c) 2002-2014, Professor Benoit Macq
        Copyright (c) 2003-2014, Antonin Descampe
        Copyright (c) 2003-2009, Francois-Olivier Devaux
        Copyright (c) 2005, Herve Drolon, FreeImage Team
        Copyright (c) 2002-2003, Yannick Verschueren
        Copyright (c) 2001-2003, David Janssens
        Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France
        Copyright (c) 2012, CS Systemes d'Information, France
       
        All rights reserved.
       
        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions
        are met:
        1. Redistributions of source code must retain the above copyright
           notice, this list of conditions and the following disclaimer.
        2. Redistributions in binary form must reproduce the above copyright
           notice, this list of conditions and the following disclaimer in the
           documentation and/or other materials provided with the distribution.
       
        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS `AS IS'
        AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
        IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
        ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
        LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
        CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
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        SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
        INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
        CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
        ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
        POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes OpenSSL.

      Copyright (c) 1998-2019 The OpenSSL Project.  All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
      are met:

      1. Redistributions of source code must retain the above copyright
         notice, this list of conditions and the following disclaimer.

      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in
         the documentation and/or other materials provided with the
         distribution.

      3. All advertising materials mentioning features or use of this
         software must display the following acknowledgment:
         "This product includes software developed by the OpenSSL Project
         for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

      4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
         endorse or promote products derived from this software without
         prior written permission. For written permission, please contact
         openssl-core@openssl.org.

      5. Products derived from this software may not be called "OpenSSL"
         nor may "OpenSSL" appear in their names without prior written
         permission of the OpenSSL Project.

      6. Redistributions of any form whatsoever must retain the following
         acknowledgment:
         "This product includes software developed by the OpenSSL Project
         for use in the OpenSSL Toolkit (http://www.openssl.org/)"

      THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
      EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR
      ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
      SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
      NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
      LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
      HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
      STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
      ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
      OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes OpenSSL.

      Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
      are met:
      1. Redistributions of source code must retain the copyright
         notice, this list of conditions and the following disclaimer.
      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in the
         documentation and/or other materials provided with the distribution.
      3. All advertising materials mentioning features or use of this software
         must display the following acknowledgement:
         "This product includes cryptographic software written by
         Eric Young (eay@cryptsoft.com)"
         The word 'cryptographic' can be left out if the rouines from the library
         being used are not cryptographic related :-).

18



1Curve Pilot PressSync

      4. If you include any Windows specific code (or a derivative thereof) from
         the apps directory (application code) you must include an acknowledgement:
         "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

      THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
      ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
      ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
      FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
      DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
      OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
      HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
      LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
      OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
      SUCH DAMAGE.
    
------------------------------------------------------------

This product includes Qt.

      The software uses Qt, licensed under LGPL v3. The Qt Toolkit is Copyright (C) 2019
 The Qt Company Ltd.

      Portions of this software are copyright (C) 2006-2015 The FreeType Project
 (www.freetype.org). All rights reserved.
      
      Copyright (C) 1991-2011, Thomas G. Lane, Guido Vollbeding.
      This software is based in part on the work of the Independent JPEG Group.
      
      Secure Hash Algorithm SHA-3 - brg_endian
      Copyright (c) 1998-2013, Brian Gladman, Worcester, UK. All rights reserved.

      LICENSE TERMS

      The redistribution and use of this software (with or without changes)
      is allowed without the payment of fees or royalties provided that:

       1. source code distributions include the above copyright notice, this
          list of conditions and the following disclaimer;

       2. binary distributions include the above copyright notice, this list
          of conditions and the following disclaimer in their documentation;

       3. the name of the copyright holder is not used to endorse products
          built using this software without specific written permission.

      DISCLAIMER

      This software is provided 'as is' with no explicit or implied warranties
      in respect of its properties, including, but not limited to, correctness
      and/or fitness for purpose.
    
------------------------------------------------------------

This product includes QtCopyDialog.

      Copyright (c) 2009 Nokia Corporation and/or its subsidiary(-ies).
      All rights reserved.

      BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
      WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
      EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
      OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
      KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
      LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
      THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
    
------------------------------------------------------------

This product includes QtMigration.

        Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
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        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Digia Plc and its Subsidiary(-ies) nor the names
            of its contributors may be used to endorse or promote products derived
            from this software without specific prior written permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE."
    
------------------------------------------------------------

This product includes QtService.

        Copyright (C) 2010 Nokia Corporation and/or its subsidiary(-ies).

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Nokia Corporation and its Subsidiary(-ies) nor
            the names of its contributors may be used to endorse or promote
            products derived from this software without specific prior written
            permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes QtSingleApplication.

        Copyright (C) 2010 Nokia Corporation and/or its subsidiary(-ies). All rights
 reserved.

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Nokia Corporation and its Subsidiary(-ies) nor
            the names of its contributors may be used to endorse or promote
            products derived from this software without specific prior written
            permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
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        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

    
------------------------------------------------------------

This product includes QtSql.

      Copyright (c) 2009 Nokia Corporation and/or its subsidiary(-ies).

      BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
      WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
      EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
      OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
      KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
      LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
      THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
    
------------------------------------------------------------

This product includes LibTIFF.

      Copyright (c) 1988-1997 Sam Leffler
      Copyright (c) 1991-1997 Silicon Graphics, Inc.

      Permission to use, copy, modify, distribute, and sell this software and
      its documentation for any purpose is hereby granted without fee, provided
      that (i) the above copyright notices and this permission notice appear in
      all copies of the software and related documentation, and (ii) the names of
      Sam Leffler and Silicon Graphics may not be used in any advertising or
      publicity relating to the software without the specific, prior written
      permission of Sam Leffler and Silicon Graphics.

      THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
      EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
      WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

      IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
      ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
      OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
      WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
      LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
      OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes XercesC.

    NOTICE file corresponding to section 4(d) of the Apache License, Version 2.0, in this
 case for the Apache Xerces distribution.

    This product includes software developed by
    The Apache Software Foundation (http://www.apache.org/).

    Portions of this software were originally based on the following:
     - software copyright (c) 1999, IBM Corporation., http://www.ibm.com.
    
------------------------------------------------------------

This product includes XMP Toolkit.
Copyright (c) 2020, Adobe
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
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   list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
   this list of conditions and the following disclaimer in the documentation
   and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its
   contributors may be used to endorse or promote products derived from
   this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
------------------------------------------------------------

This product includes zlib.

 (C) 1995-2022 Jean-loup Gailly and Mark Adler

  This software is provided 'as-is', without any express or implied
  warranty.  In no event will the authors be held liable for any damages
  arising from the use of this software.

  Permission is granted to anyone to use this software for any purpose,
  including commercial applications, and to alter it and redistribute it
  freely, subject to the following restrictions:

  1. The origin of this software must not be misrepresented; you must not
     claim that you wrote the original software. If you use this software
     in a product, an acknowledgment in the product documentation would be
     appreciated but is not required.
  2. Altered source versions must be plainly marked as such, and must not be
     misrepresented as being the original software.
  3. This notice may not be removed or altered from any source distribution.

  Jean-loup Gailly        Mark Adler
  jloup@gzip.org          madler@alumni.caltech.edu
    
------------------------------------------------------------
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2.  Curve Pilot and PressSync Pilot
If you have a PressSync license, you will get two applications after installing Curve Pilot on your
computer:

• Curve Pilot, which contains the IntelliCurve (DGC editor, strategy editor) and the PressSync
(PressSync curve set editor) functionality,

• PressSync Pilot, which only contains the PressSync functionality.

This document describes the PressSync functionality. For an explanation of the IntelliCurve
functionality, please see the IntelliCurve manual.
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3.  What is a PressSync Curve?
Curve Pilot / PressSync Pilot comes bundled with 400 PressSync curves. Those are pre-defined dot
gain compensation curves of various forms and shapes that can fit the dot gain compensation needs of
most presses.

Using PressSync curves significantly reduces the complexity of dot gain compensation in workflows.

3.1.  PressSync Curve Names

PressSync compensation curves are defined by a letter (A to H) and a number (20 to 70): A40, D20,
F30, etc. The letter indicates the general shape of the curve in the highlights and in the shadows. The
number indicates the compensation value for the 50% dot (midtone).

20 50 70

A

E

H
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3.2.  PressSync Example Curves

The A50 curve increases dot gain in the highlights (forcing the press to print darker in the highlights),
and reduces dot gain in the shadows (thus forcing the press to print lighter in the shadows). The
H50 curve exhibits the opposite behavior. Both curves exhibit an inflection point (where their slope
changes sign) in the midtone.

 

 

The E70 curve increases dot gain throughout the tonal range, correcting the midtone to 70%. The E20
curve decreases dot gain throughout the tonal range, forcing the midtone to 20%.

 

 

3.3.  Minimum and Maximum Values

A PressSync curve can also contain information about a minimum and a maximum value.

The minimum value is the correction / compensation for the first non-zero tone. For example, if the
minimum is set at 6%, the first tone value after zero will be adjusted to 6% as shown below.
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Note:  Regardless of the minimum value you choose, the 0% tone remains at 0%. As a result,
the 0% tone will not be screened.

The maximum value is the correction / compensation for the tone just below 100%. For example, if the
maximum value is 96%, a tone of 99.5% for example will be corrected to 96% and screened as shown
below.

 

 

Note:

The 100% tone (the solids) will use the 100% level of the screen. This means that:

• for screens that do no use surface screening, solids will be kept as solids (not screened),
• for screens that use surface screening, solids will use the surface screening pattern

defined for 100% in the screen.
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Tip:

If you want to use your maximum value to screen the solids (so 100% is screened at 96% for
example), you should:

• use a flexible PressSync Curve,

• set the Maximum Value you want to use for screened your 100% tones,

• deselect the Keep 100% option in your curve.

27



4 Curve Pilot PressSync

4.  Finding a PressSync Curve for a Printing
Ink

To find a PressSync curve for an individual ink, you need to print a vignette of this ink, measure it and
enter the values into Curve Pilot.

Note:  You can only do this in Curve Pilot, not PressSync Pilot.

1. Print a vignette of the ink you want to compensate with a PressSync curve (without using any dot
gain compensation).

2. In Curve Pilot, go to File > New > DGC (.dgc).
3. Enter your ink measurements as you would when creating a DGC curve (see the IntelliCurve manual

for details).
4. In the Show Curves area, make sure Compensation curve is selected, then select PressSync curve.

This shows the best PressSync curve to use for your ink and printing conditions (press, substrate...)
with a red dotted line on the graph.
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You can see the PressSync curve name beside PressSync curve.

By default, the PressSync curve shown is the one that fits the compensation points the best. The
compensation points are the compensation values for each measurement you have entered (they
are shown as blue crosses on the graph).

5. If you want a PressSync curve that fits the smoothed compensation curve (blue curve) better
(instead of the compensation points), select Use Smoothed Curve.
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6. If desired, enter a Minimum Value and a Maximum Value to use for your PressSync curve (see

Minimum and Maximum Values for information).
The minimum and maximum values you entered are shown beside the curve name. 

7. Save your curve:
a) go to File > Save,
b) enter a (meaningful) File Name for your PressSync curve,
c) click OK.
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5.  What is a PressSync Curve Set?
A PressSync curve set is a collection of predefined dot gain compensation curves, each attached to an
ink (a process ink or a spot color defined in Esko's CMS database).

Curve Pilot / PressSync Pilot creates and saves PressSync curve sets in the .prsync file format.
A .prsync file contains information about the desired printing condition, measurement data, the
actual dot gain compensation curves, and history data related to curve set setup and/or measurement
actions.

When sending a print job to your RIP application, you typically associate one or more .prsync files
with it. This way, every separation in your job is compensated with the appropriate PressSync curve.
For the details please refer to your RIP application manual.
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6.  Creating a PressSync Curve Set for Your
Press

You can create either :

• An empty curve set: manually pick the PressSync curves for your inks without measuring your
press output (for example if a third-party application gave you specific PressSync Curves to use).

• A curve set with measurements: measure a few press runs and compare them to target values to
get your PressSync curves.

This way you can match a specification (ISO, GRACol, SWOP...) or another reference (if for example
you have a good curve set for one of your presses, and want to make a similar one for a second
press).

Note:  We recommend you create a curve set with measurements, rather than matching the
PressSync curves to your inks manually.

6.1.  Creating an Empty Curve Set

You can create an empty curve set if you are not planning to measure your press runs at all and want to
manually pick the PressSync curves for your inks. Do this for example if a third-party application gave
you specific PressSync Curves to use.

In Curve Pilot or PressSync Pilot:

1. Go to File > New then select PressSync Curve Set (.prsync).
In PressSync Pilot, you can also click the New... button at the bottom of the PressSync Curve Set
Explorer panel.

2. In the Create New Curve Set dialog, choose An empty curve set, and click OK.

This opens a dialog with an empty PressSync curve set.

By default, the curve set contains the four process inks (Cyan, Magenta, Yellow and Black), and a
channel called Other Inks (whose compensation will be used for any job ink not defined in the curve
set).

At the start, the Curve Name shows LIN (linear), which means that no compensation curve is
applied to those inks.
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3. Click Setup... to open the Setup dialog.
4. Enter your name in Changed by and a Reason for the setup change.
5. If desired, enter a Curve Set Description.

Note:  This will be shown in the  field of the curve set dialog (you can only edit the
contents of this field from the Setup dialog).

You will enter the Curve Set Name when saving the curve set.
6. Add extra inks to the curve set if desired:

a) click + at the bottom of the Spot Colors list,
b) in the Choose Inks dialog, choose the Ink Book,
c) choose or enter the Ink Name and click OK.

When entering an ink name manually, you can use the full ink name or the short ink name. Make
sure you use either the exact spelling from your CMS database or the ocial short name.
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Note:  You can add any ink that is defined in Esko's CMS database, but you cannot remove
the default channels (Cyan, Magenta, Yellow, Black and Other Inks).

Tip:

If you are working on a curve set from/for a different system (with a different CMS), you can
add inks that are not registered in your CMS database:

1. Select <unregistered ink book> in the Ink Book field.
2. Type the name of your ink book.
3. The Ink Name field will show <unregistered ink>. Type the name of your ink.
4. You will see a warning. Click OK.

When working with unregistered inks, you will see a "U" icon ( ).

 

 
7. Click OK when you are done with the setup.
8. To assign curves manually to your inks:

a) Click Select Curve Names... in the curve set dialog.
b) In the Select Curve Names dialog that opens, choose a PressSync Curve for each ink: choose

the letter, the number and enter a minimum and maximum value if necessary.

34



6Curve Pilot PressSync

Note:  Linear means that no curve is assigned to the ink (so no dot gain compensation is
applied).
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Tip:

To view the curves you picked on the bottom graph, check their boxes under . You can

also click  to show all process colors curves, or to hide all curves.

 

 

You can click  to zoom in, then see different areas of the graph using the scroll bars or

your mouse, and click  to zoom out.

You can click a particular point of a curve to see its coordinates.
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c) Click OK when you are done.

You can now see the curves you have picked in the curve set dialog.

You can also view them on the graph, and zoom in and out.

 

 
9. Save your curve set:

a) Go to File > Save or use Ctrl+S.
b) Give your curve set a name and click OK.

6.2.  Creating a Curve Set from Measurements

To create a curve set with measurements, you need to measure a few press runs and compare them to
target values.
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You can either:

• Start from a standard curve set (delivered with Curve Pilot), if you want to compensate your press
output to match a target curve from a specification (ISO, GRACol, SWOP...).

• Start from an existing curve set, if you have already created a PressSync curve set that you want
to use as a basis for your new curve set. Do this for example if you have a good curve set for one of
your presses, and you want to make a similar one for a second press.

In both cases, you can use the predefined/existing setup and only take measurements from a few press
runs, or modify the setup to fit your needs before measuring your output.

1. Go to File > New then select PressSync Curve Set (.prsync).
In PressSync Pilot, you can also click the New... button at the bottom of the PressSync Curve Set
Explorer panel.

2. In the Create New Curve Set dialog:
a) choose either A standard or An existing curve set,
b) select the curve set you want to start from in the list,

Important:

Make sure you pick a curve set with the type of target you want, as you won't be able to
change it afterwards.

When starting from a standard, the standard name indicates the type of target you will
have to measure:

• standard names starting with 3ck (for example "3ck_GRAColG7.prsync") work with a 3
colors + K target (you will have to measure patches for two colors: a Cyan-Magenta-
Yellow composite and Black),

• standard names starting with cmyk (for example "cmyk_ISO_Newsprint.prsync") work
with a CMYK target (you will have to measure patches for four colors: Cyan, Magenta,
Yellow and Black).

Existing curve sets have the names you have given them. We recommend you include a
reference to the target in the curve set names. If you haven't, you can open the existing
curve set to check what kind of target it uses (in the Process Colors Setup on page 42)
before creating a new curve set from it.

Do not start from an "empty" existing curve set when creating a curve set with
measurements.

c) click OK.

This opens an untitled.prsync curve set in a dialog, with the inks and setup of the standard/
existing curve set you selected.

If you started from a standard curve set, you will see the four process inks (Cyan, Magenta, Yellow
and Black), and a channel called Other Inks (whose compensation will be used for any job ink that
isn't defined in the curve set).

At the start, each Curve Name shows LIN (linear), which means that no compensation curve is
applied on those inks.
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3. Customize your setup.
4. Take press run measurements to find the best PressSync Curve to use for each ink (see Taking

Press Runs Measurements on page 49).
We recommend print and measure a Universal Target then production jobs with a control strip.

5. Save your curve set:
a) Go to File > Save or use Ctrl+S.
b) Give your curve set a name and click OK.

6.2.1.  Customizing Your Setup

1. Click the Setup... button in the curve set dialog to open the Setup dialog.
2. Use the Setup dialog to:
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• define the target values that your measurements will be compared to (for Process Colors, Gray
Balance and Spot Colors),

• add or remove spot colors to be compensated by your curve set.

For details, see:

• General Setup on page 40,

• Process Colors Setup on page 42,

• Gray Balance Setup on page 44,

• Spot Colors Setup on page 47.
3. Click OK when you are done with the setup.

General Setup
In the curve set's Setup dialog:
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1. Enter your name in Changed by and a Reason for the setup change.

You will enter the Curve Set Name when saving the curve set.
2. If you want to calculate the reference values (to compare your measurements to) from an icc profile,

select it in Target Profile Name.

If you started from a standard curve set, the corresponding icc profile is selected by default (for
example, GRACol2006_Coated1v2.icc if you started from 3ck_GRAColG7.prsync).

You can also select <none>, if you want to define the reference values manually.
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Note:  You can click on  to see information about the selected target profile.
 

 

You will see a Summary of the target curves selected for process colors, gray balance and spot
colors.

3. If desired, enter/change the Curve Set Description.

Note:  This will be shown in the  field of the curve set dialog (you can only edit the
contents of this field from the Setup dialog).

Process Colors Setup
In the Process Colors tab, you need to choose how to measure your process colors on print (on
a universal target or a control strip on the side of a job), and what target values to compare your
measurements to.

Note:

Depending on the curve set you started from (see Creating a Curve Set from Measurements on
page 37), you will need to choose either:

• target references / values for CMY and for Black,

• target references / values for Cyan, Magenta, Yellow and Black.
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1. Choose the unit of Measure to use for your press runs measurements. You can choose:

• density, to measure your patches with a "Status E" (for Europe) or "Status T" (for the US)
densitometer,

• %DotArea, to measure how much of the area is taken by the dot (in percentage),
• DeltaE-P, to measure the color difference between patch and paper (this is illuminant

dependant and based on CIE-1976),
• %DeltaE-SP, to measure the color difference between patch and paper, proportionally to the

color difference between solid and paper (this is illuminant dependant and based on CIE-1976).

Tip:  Click  to see more information about the units.

You will need a densitometer if you choose density or %DotArea, and a spectrophotometer if you
choose DeltaE-P or %DeltaE-SP.
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This unit will be used to define the desired values for Paper and Solid, Universal Target and Control
Strip below.

2. In Target Curves, choose how to calculate the target values for process colors. You can either:

• Select Use Profile for Tone Target Curves if you want to use data from the Target Profile you
selected in the General tab to calculate target values.

When you select this, the CMY and Black (or Cyan, Magenta, Yellow and Black) lists will be
greyed out.

• Select Linear (in the lists) if you want linear print values (without dot gain) as target values.
• Select User Defined if you want to enter the target values manually instead of getting them from

a curve or a profile.
• Select any reference dgc curve present in the DGC or Curves database to calculate the target

values.

Tip:  If you want to start from predefined values but refine them for your needs, select the
predefined values first (Target Profile, Linear or a reference dgc curve) then select User
Defined. This will keep the predefined values but you will be able to edit them.

3. Check the desired values for Paper and Solid, and adjust them as necessary.
For example, if you chose to work with densities, adjust the density of paper and solid as necessary.

4. For the Universal Target:

• If you have chosen User Defined in your Target Curves, enter the desired values for 1/4, 1/2 and
3/4 tones.

Note:  The Paper and Solid values are fixed. They are either 0% and 100% (if you are
using %DotArea or %DeltaE-SP as unit) or the values you entered for Paper and Solid (if
you are using density or DeltaE-P as unit).

• Otherwise, the values are calculated automatically based on what you chose in Target Curves.
5. For the Control Strip:

• If you have chosen User Defined in your Target Curves, enter the number of Patches you want to
measure, their percentages and their desired values.

Note:  The values of the 0% and the 100% patch are fixed. They are either 0% and 100%
(if you are using %DotArea or %DeltaE-SP as unit) or the values you entered for Paper
and Solid (if you are using density or DeltaE-P as unit).

• Otherwise, the values are calculated automatically based on what you chose in Target Curves,
but you can still select the number of Patches and their percentages.

Gray Balance Setup
Checking Gray Balance is printing different intensities of gray using Cyan, Magenta and Yellow inks,
and measuring Lab values on the print to check how neutral the gray is.

In the Gray Balance tab, you need to choose what target values to compare your gray prints
measurements to (for prints on a universal target or a control strip on the side of a job).
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1. In Target, choose how to calculate the target values for gray balance. You can either:

• Select From Target Profile if you want to use data from the Target Profile you selected in the
General tab to calculate target values.

• Select User Defined if you want to enter the target values manually instead of getting them from
a curve or a specification.

• Select Neutral Paper if you want to calculate the target values relatively to the paper and solid
(using the paper's Lab values as 0% gray, the solid's as 100%, and calculating the values in
between).

• Select the built-in gray target of the specification (for example GRAColG7 (built-in) if you
started from 3ck_GRAColG7.prsync) to calculate the target values.

You can click on  to see information about the selected target.

45



6 Curve Pilot PressSync

Tip:  If you want to start from predefined values but refine them for your needs, select
the predefined values first (Target Profile, Neutral Paper or the built-in target of the
specification) then select User Defined. This will keep the predefined values but you will be
able to edit them.

2. The Universal Target will contain a Light and a Dark gray square, composed of cyan, magenta and
yellow, with the cyan values fixed at respectively 25% and 50%.

• If you have chosen User Defined as Target:

• enter the desired magenta and yellow values for the Light and the Dark gray squares,

• enter the desired Lab values of the cyan-magenta-yellow combination for the Light and the
Dark gray squares,

• enter the desired Lab values of the Paper and the Solid patch (100% cyan, 100% magenta and
100% yellow).

• If you have chosen Neutral Paper as Target, enter the desired Lab values of the Paper and the
Solid patch.

The target values for the Light and Dark gray squares are calculated automatically.
• If you selected either the built-in gray target of the specification or the target profile as Target,

all the target values are calculated automatically.
3. The Control Strip on the side of a production job will contain patches of gray composed of cyan,

magenta and yellow.

• If you have chosen User Defined as Target:

• enter the number of Patches you want to measure,

• enter the percentages of cyan, magenta and yellow to print for each of those patches,

• enter the desired Lab values of your patches, the Paper and the Solid patch (100% cyan,
100% magenta and 100% yellow).

• If you have chosen Neutral Paper as Target:

• enter the number of Patches you want to measure,

• enter the percentage of cyan to print for each patch (the percentages of magenta and yellow
are calculated automatically),

• enter the desired Lab values of the Paper and the Solid patch (100% cyan, 100% magenta and
100% yellow).

• If you selected either the built-in gray target of the specification or the target profile as Target,
enter the number of Patches you want to measure and the percentage of cyan to print for each
patch.

All the other values are calculated automatically.
4. If you have chosen User Defined or Neutral Paper, you can also set desired Lab values for the Solid

Process Colors if desired (you can get those from your ink vendor).
Otherwise those values are defined automatically.
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Spot Colors Setup
In the Spot Colors tab, you can add or remove spot colors. For each spot color you add, you can choose
how to measure it on print (on a universal target or a control strip on the side of a job), and what target
values to compare your measurements to.

You can also define what to do when encountering job spot colors that aren't defined in the setup.

 

 

1. To add a spot color:
a) click + at the bottom of the Spot Colors list,
b) in the Choose Inks dialog, choose the Ink Book,
c) choose or enter the Ink Name and click OK.
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When entering an ink name manually, you can use the full ink name or the short ink name. Make
sure you use either the exact spelling from your CMS database or the ocial short name.

Note:  You can add any ink that is defined in Esko's CMS database, but you cannot remove
the default channels (Cyan, Magenta, Yellow, Black and Other Inks).

Tip:

If you are working on a curve set from/for a different system (with a different CMS), you can
add inks that are not registered in your CMS database:

1. Select <unregistered ink book> in the Ink Book field.
2. Type the name of your ink book.
3. The Ink Name field will show <unregistered ink>. Type the name of your ink.
4. You will see a warning. Click OK.

When working with unregistered inks, you will see a "U" icon ( ).

2. Select the spot color you added to define its setup.
3. Choose the unit of Measure to use for your press runs measurements. You can choose:

• density, to measure your patches with a "Status E" (for Europe) or "Status T" (for the US)
densitometer,

• %DotArea, to measure how much of the area is taken by the dot (in percentage),
• DeltaE-P, to measure the color difference between patch and paper (this is illuminant

dependant and based on CIE-1976),
• %DeltaE-SP, to measure the color difference between patch and paper, proportionally to the

color difference between solid and paper (this is illuminant dependant and based on CIE-1976).

Tip:  Click  to see more information about the units.

You will need a densitometer if you choose density or %DotArea, and a spectrophotometer if you
choose DeltaE-P or %DeltaE-SP.

This unit will be used to define the desired values for Paper and Solid, Universal Target and Control
Strip below.

4. Choose how to calculate the target values for this spot color. You can either:

• Select Linear if you want linear print values (without dot gain) as target values.
• Select User Defined if you want to enter the target values manually instead of getting them from

a curve.
• Select any reference dgc curve present in the DGC or Curves database to calculate the target

values (only when measuring density or %DotArea).

Tip:  If you want to start from predefined values but refine them for your needs, select the
predefined values first (Linear, or a reference dgc curve) then select User Defined. This will
keep the predefined values but you will be able to edit them.

5. Check the desired values for Paper and Solid, and adjust them as necessary.
For example, if you chose to work with densities, adjust the density of paper and solid as necessary.

6. For the Universal Target:
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• If you have chosen User Defined, enter the desired values for 1/4, 1/2 and 3/4 tones.

Note:  The Paper and Solid values are fixed. They are either 0% and 100% (if you are
using %DotArea or %DeltaE-SP as unit) or the values you entered for Paper and Solid (if
you are using density or DeltaE-P as unit).

• Otherwise, the values are calculated automatically based on what you chose (Linear printing or a
reference dgc curve).

7. For the Control Strip:

• If you have chosen User Defined, enter the number of Patches you want to measure, their
percentages and their desired values.

Note:  The values of the 0% and the 100% patch are fixed. They are either 0% and 100%
(if you are using %DotArea or %DeltaE-SP as unit) or the values you entered for Paper
and Solid (if you are using density or DeltaE-P as unit).

• Otherwise, the values are calculated automatically based on what you chose, but you can still
select the number of Patches and their percentages.

6.2.2.  Taking Press Runs Measurements

We recommend you first print and measure a Universal Target to find the initial curves, then refine
those curves by printing production jobs and measuring their control strips.

Measuring a Universal Target
The Universal Target is a test form designed by Esko for setting up dot gain compensation curves for
your press. It is typically used when you have no idea about what PressSync curves to use.

When measuring a Universal Target, you will look for where the target values (defined in the setup)
are in the vignettes. This will be used to calculate PressSync curves for each ink.

For example, if you find the target value for 50% Black at 40%, Curve Pilot will know that the Black
curve needs to compensate a 10% dot gain in the midtones.

1. Print a Universal Target without any dot gain compensation.

Note:

If you have a good starting value, you can create a preliminary curve set and use it to RIP
and print the universal target.

For example, if you usually need to drop your midtones by 10%, you can use a curve set
containing an E40 curve for each ink. Concentric Screening users usually start from C45
curves.

See Using PressSync Curves in Nexus on page 64 or Using a PressSync Curve Set in FlexRip
on page 66 for details.

2. Click the Measure... button in the curve set dialog to open the Measure Curve Set dialog.
3. Select Universal Target and click OK.

This opens the Measure Universal Target dialog.
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4. Enter your name in Changed by and a Reason for the setup change.
5. In most cases, you don't need to set anything in the Universal Target tab.

However, if you have printed the Universal Target with a preliminary curve set (see step 1), you
should:

• select The Universal Target is printed with different PressSync Curves,

• define the PressSync Curve used for each ink: choose the letter, the number and enter a
minimum and maximum value if necessary.

6. Go to the Process Colors tab and measure the process colors vignettes.
7. Go to the Gray Balance tab and measure the gray balance.
8. Go to the Spot Colors tab and measure the spot colors vignettes.
9. Click Results... to see the best PressSync Curves to compensate your measurements (see Resulting

Curves on page 52).
10. Click Save... and choose to:

• Save curves if you want to save the measurements and the curves, and use those curves in your
PressSync curve set.

• Save measurements only if you only want to save the measurements but not the curves.

Note:  Keep the PressSync curve set dialog open as you will now be measuring a control strip.

Measure Process Colors
For process colors, you will be measuring either:

• the Cyan, Magenta, Yellow and Black vignettes if you started from a curve set working with a CMYK
target,

• the CMY and the Black vignette if you started from a curve set working with a 3 colors + K target.

See Creating a Curve Set from Measurements on page 37 for more information.

Attention:

Make sure your measuring device is configured to measure in the unit defined in the setup
(density, %DotArea, ∆E-P or %∆E-SP).

You can see the unit to use in the tab itself.

In the Process Colors tab:

1. Measure the solid patch of the vignette, and enter the value found in the Measured Solid ... field.
Press Tab or Enter to enable the fields below.

2. Search for the 1/4 tone target value (that you defined in the setup).

Tip:  Start by measuring the 25% patch on the vignette, and move forwards or backwards
until you find the value you are looking for.

Enter that value in the leftmost field (<unit> of <value> found at: where <unit> is the measuring unit
you chose in the setup, and <value> is the target value you have set for the 1/4 tone).

3. Search for the 1/2 and 3/4 tones target values in the same way.
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Enter those values in the middle and rightmost fields.
4. Repeat this for each vignette (either Cyan, Magenta, Yellow and Black, or CMY and Black).

Measure Gray Balance

Attention:  For gray balance, you will need a spectrophotometer, to measure Lab values.

In the Gray Balance tab:

1. Measure the Lab values of the substrate and enter them in the L, a and b fields.
Press Tab or Enter to enable the fields below.

2. In the Dark Square, find the Lab target value defined in the setup.
Enter the coordinates of the position where you found that value (the X coordinate is a letter, the Y
coordinate a number).

3. In the Light Square, find the Lab target value defined in the setup.
Enter the coordinates of the position where you found that value.

Measure Spot Colors
Although the Universal Target is designed to be used for process colors, you can also use it to print and
measure spot colors.

To do this, make a copy of the Universal Target PDF file, and create a version that also contains
vignettes for the required spot colors (copy one of the process colors' vignettes and change its ink
settings).

Note:  The spot colors you use must be defined in the curve set setup.

Attention:

Make sure your measuring device is configured to measure in the unit defined in the setup
(density, %DotArea, DeltaE-P or %DeltaE-SP).

You can see the unit to use in the tab itself (for spot colors, it is usually a colorimetric unit:
DeltaE-P or %DeltaE-SP).

In the Spot Colors tab:

1. Measure the solid patch of the first spot color vignette, and enter the value found in the Measured
Solid ... field.
Press Tab or Enter to enable the fields below.

2. Search for the 1/4 tone target value (that you defined in the setup).

Tip:  Start by measuring the 25% patch on the vignette, and move forwards or backwards
until you find the value you are looking for.

Enter that value in the leftmost field (<unit> of <value> found at: where <unit> is the measuring unit
you chose in the setup, and <value> is the target value you have set for the 1/4 tone).

3. Search for the 1/2 and 3/4 tones target values in the same way.

Enter those values in the middle and rightmost fields.
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4. Repeat this for each spot color vignette, including Other Inks.

Resulting Curves

1. When you have entered all your measurements, click Results... to see the best PressSync curves to
use.
 

 

Note:

You can also do this after entering the measurements for one or more inks, to see curve(s)
for the ink(s). For example, enter the Cyan measurements and click Results... to see the
Cyan curve.

You can then click Back To Measurements to go back and enter the rest of your
measurements.

You can see all the curves at the top of the dialog (Conclusion).
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• The Process Colors tab shows the measurements you entered for the process colors and the
Gray Balance, and the resulting PressSync curve for each process color (in black in the Result
area at right).

• The Spot Colors tab shows the measurements you entered for the spot colors, and the resulting
PressSync curve for each spot color.

Note:

If the PressSync curve found for an ink doesn't fit the compensation points calculated from
the measurements properly, it will be shown in red.

If no PressSync curve could be calculated because there are no or invalid measurements,
you will see  instead of a curve name.

In that case, you can click the Back To Measurements button to verify your measurements.

If your measurements are correct (your press just prints that way), you should use Dot Gain
Compensation instead of PressSync curves. See the IntelliCurve manual.

2. In the Process Colors tab, you can:
a) Choose if you want to compensate mostly colors or mostly neutrals: in Select curves based on,

choose either:

• Tone measurements only if you want to pick curves that compensate mostly process colors,
and not gray balance,

• Both Tone and Gray Balance measurements if you want to pick average curves that
compensate everything (process colors and gray balance),

• Mainly Gray Balance measurements if you want to pick curves that compensate mostly gray
balance, and not process colors.

b) Click Preview Curves... to display each curve in a graph.
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This shows:

• the original curve in gray,
• the new curve in black,
• the compensation points calculated from process (or spot) color measurements in blue,
• the compensation points calculated from gray balance measurements in gray,
• the standard deviation (Std), that shows how far the curve is from the compensation points

(this should be under 2% for the curve to fit properly).

Depending on what you chose for gray balance importance, the curve will be closer to the
process color compensation points or the gray balance compensation points.

3. In the Spot Colors tab, you can click Preview Curves... to display each curve in a graph.
4. Click Save... and choose to:

• Save curves if you want to save the measurements and the curves, and use those curves in your
PressSync curve set.

Note:  If the Result area showed  instead of a curve name, that ink's previous curve will
not be changed.

• Save measurements only if you only want to save the measurements but not the curves.

This will save the measurement as incomplete, but you can edit it again or save the curves later
(see Continuing an Incomplete Measurement on page 59).

Measuring a Control Strip of a Production Sheet
We recommend you print a production job using the PressSync curves you found after measuring the
Universal Target. This job should have a control strip, that you will measure to refine your PressSync
curves.

Note:

You can use any type of control strip that contains several patches of each ink (for example
25%, 50%, 75% and 100%).

Make sure the patches of your control strip and what you have defined in the setup match.
If you do not have a control strip matching your setup, change the setup (see Process Colors
Setup on page 42, Gray Balance Setup on page 44 and Spot Colors Setup on page 47).

1. Use FlexRip or Nexus to RIP and print a production job (containing a control strip) using the
PressSync curves you found after measuring the Universal Target.
See Using PressSync Curves in Nexus on page 64 or Using a PressSync Curve Set in FlexRip on
page 66 for details.

2. Back in your Curve Pilot curve set, click the Measure... button again.
3. In the Measure Curve Set dialog that opens, select A control strip of a production sheet and click

OK.
This opens the Measure Production Sheet dialog.

4. Enter your name in Changed by and a Reason for the setup change.
5. In most cases, you don't need to set anything in the Production Sheet tab.
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However, if for some reason you have printed the Production Sheet with a different curve set than
the one you found from the Universal target measurements, you should:

• select The production sheet is printed with different PressSync Curves,

• define the PressSync Curve used for each ink: choose the letter, the number and enter a
minimum and maximum value if necessary.

6. Go to the Process Colors tab and measure the process colors vignettes.
7. Go to the Gray Balance tab and measure the gray balance.
8. Go to the Spot Colors tab and measure the spot colors vignettes.
9. Click Results... to see the best PressSync Curves to compensate your measurements (see Resulting

Curves on page 56).
10. Click Save... and choose to:

• Save curves if you want to save the measurements and the curves, and use those curves in your
PressSync curve set.

• Save measurements only if you only want to save the measurements but not the curves.

Measure Process Colors
For process colors, you will be measuring either:

• the Cyan, Magenta, Yellow and Black vignettes if you started from a curve set working with a CMYK
target,

• the CMY and the Black vignette if you started from a curve set working with a 3 colors + K target.

See Creating a Curve Set from Measurements on page 37 for more information.

Attention:

Make sure your measuring device is configured to measure in the unit defined in the setup
(density, %DotArea, ∆E-P or %∆E-SP).

You can see the unit to use in the tab itself.

In the Process Colors tab:

1. Depending on what you have defined in the setup:

• Measure the 0% and 100% patches, and enter the values found in the corresponding fields.
• Measure the solid patch, and enter the value found in the Measured Solid ... field.

You can see the desired value(s) defined in the setup between brackets.

Press Tab or Enter to enable the other fields.
2. Measure the other patches (defined in the setup) and enter the values found in the corresponding

fields.

You will see the desired values (defined in the setup) below those fields.
3. Repeat this for each vignette (either Cyan, Magenta, Yellow and Black, or CMY and Black).
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Measure Gray Balance

Attention:  For gray balance, you will need a spectrophotometer, to measure Lab values.

In the Gray Balance tab:

1. Measure the Lab values of the substrate and enter them in the L, a and b fields below.

You can see the desired values (defined in the setup) between brackets below.
2. Measure the Lab values of the solid (100%) patch and enter them in the L, a and b fields under the

white patch.

Press Tab or Enter to enable the other fields.
3. Measure the other patches (defined in the setup) and enter the Lab values found in the

corresponding fields.

You will see the desired values below those fields.

Tip:  The numbers in the patches indicate the CMY composition (for example: 25, 19, 19 is
25% Cyan, 19% Magenta and 19% Yellow).

Measure Spot Colors

Note:  The spot colors you use must be defined in the curve set setup.

Attention:

Make sure your measuring device is configured to measure in the unit defined in the setup
(density, %DotArea, DeltaE-P or %DeltaE-SP).

You can see the unit to use in the tab itself (for spot colors, it is usually a colorimetric unit:
DeltaE-P or %DeltaE-SP).

In the Spot Colors tab:

1. Depending on what you have defined in the setup:

• Measure the 0% and 100% patches, and enter the values found in the corresponding fields.
• Measure the solid patch, and enter the value found in the Measured Solid ... field.

You can see the desired value(s) defined in the setup between brackets.

Press Tab or Enter to enable the other fields.
2. Measure the other patches (defined in the setup) and enter the values found in the corresponding

fields.

You will see the desired values (defined in the setup) below those fields.
3. Repeat this for each spot color vignette, including Other Inks.

Resulting Curves

1. When you have entered all your measurements, click Results... to see the best PressSync curves to
use.
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Note:

You can also do this after entering the measurements for one or more inks, to see curve(s)
for the ink(s). For example, enter the Cyan measurements and click Results... to see the
Cyan curve.

You can then click Back To Measurements to go back and enter the rest of your
measurements.

You can see all the curves at the top of the dialog (Conclusion).

• The Process Colors tab shows the measurements you entered for the process colors and the
Gray Balance, and the resulting PressSync curve for each process color (in black in the Result
area at right).
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• The Spot Colors tab shows the measurements you entered for the spot colors, and the resulting
PressSync curve for each spot color.

Note:

If the PressSync curve found for an ink doesn't fit the compensation points calculated from
the measurements properly, it will be shown in red.

If no PressSync curve could be calculated because there are no or invalid measurements,
you will see  instead of a curve name.

In that case, you can click the Back To Measurements button to verify your measurements.

If your measurements are correct (your press just prints that way), you should use Dot Gain
Compensation instead of PressSync curves. See the IntelliCurve manual.

2. In the Process Colors tab, you can:
a) Choose if you want to compensate mostly colors or mostly neutrals: in Select curves based on,

choose either:

• Tone measurements only if you want to pick curves that compensate mostly process colors,
and not gray balance,

• Both Tone and Gray Balance measurements if you want to pick average curves that
compensate everything (process colors and gray balance),

• Mainly Gray Balance measurements if you want to pick curves that compensate mostly gray
balance, and not process colors.

b) Click Preview Curves... to display each curve in a graph.
 

 

This shows:

• the original curve in gray,
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• the new curve in black,
• the compensation points calculated from process (or spot) color measurements in blue,
• the compensation points calculated from gray balance measurements in gray,
• the standard deviation (Std), that shows how far the curve is from the compensation points

(this should be under 2% for the curve to fit properly).

Depending on what you chose for gray balance importance, the curve will be closer to the
process color compensation points or the gray balance compensation points.

3. In the Spot Colors tab, you can click Preview Curves... to display each curve in a graph.
4. Click Save... and choose to:

• Save curves if you want to save the measurements and the curves, and use those curves in your
PressSync curve set.

Note:  If the Result area showed  instead of a curve name, that ink's previous curve will
not be changed.

• Save measurements only if you only want to save the measurements but not the curves.

This will save the measurement as incomplete, but you can edit it again or save the curves later
(see Continuing an Incomplete Measurement on page 59).

Continuing an Incomplete Measurement
When a measurement was saved with the option Save measurements only, the measurement is saved
as incomplete (whether you filled in all the measurement fields or not). The PressSync curves resulting
from that measurement are not used for the curve set.

To edit it (if needed) and save the curves, do the following:

1. Make sure the incomplete measurement is active in the History (you should see , not  beside
it).
If it isn't, make it active (see Reverting to a Previous History Stage on page 63).

2. Click the Measure... button in the curve set dialog.
3. In the Measure Curve Set dialog, select Your last (incomplete) measurement and click OK.
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4. Complete your measurement if needed, and save the measurement and the curves.

6.2.3.  History

When opening a PressSync curve set, you can see a History tab in the curve set dialog. This contains
any previously saved setups, measurements and curves, with the most recent stage on top.

You can use it to:

• View the details of previous setups, measurements or curves.
• Revert to a previous setup, measurements or curves.
• Delete previous setups, measurements or curves that you are not using.
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For each history stage, you can see:

• its state:

•
currently active ( ),

• active but incomplete measurement ( ),

• inactive and incomplete measurement ( ),

• inactive and not linked to the current setup (greyed out),

• what has changed (for example Measured Control Strip or Setup Change),

• the Curves resulting from that action,

• the Date and time of the change.
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Note:

Incomplete measurements (  or ) do not change the curves in the curve set.

Only complete measurements  and Manual Curve Change actions do.

So if your last action is an incomplete measurement, the curves in the curve set at that point
are those resulting from the last complete measurement or manual curve change.

To finish an incomplete measurement, see Continuing an Incomplete Measurement on page 59.

Viewing Previous History Stages
• To view a previous history stage, select it and click the Show Info button.

This shows all the details of the stage you selected (setup, measurement or manual curve change),
but in read-only mode.
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Reverting to a Previous History Stage
• To revert to a previous history stage, select it and click the Set Active button. It will get a green flag

.

• Setting a completed measurement active reverts to the PressSync curves resulting from that
measurement.

• Setting an incomplete measurement active reverts to the PressSync curves used to print the
sheet measured.

• Setting a Manual Curve Change active reverts to the PressSync curves set manually at that
time.

• Setting a Setup Change active reverts to the setup version created by the setup change.

This can for example change spot colors or how to measure your prints.

Note:  Each measurement made is based on a specific setup version. When changing
the setup of the curve set or activating another setup version, the measurements
corresponding to other setup versions will be grayed out.

Deleting a Previous History Stage
To delete previous setups, measurements or curves that you are not using:

• To delete a previous history stage, select it and click the Remove button.

Attention:

You cannot delete:

• active stages (you need to first activate another stage instead),
• setup stages used by measurements (you need to delete the measurements before you

can delete the setup).
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7.  Using PressSync Curves and Curve Sets

7.1.  Using a PressSync Curve in Imaging Engine

To apply a PressSync curve on your separations when ripping a job with Imaging Engine, enter it in the
Image to Screened Separations task.

1. In the Image to Screened Separations ticket, click the Separations tab.
2. In the Default Press Curve list, select PressSync.
3. Select the letter and number of the PressSync curve you want to use.

This applies that PressSync curve to all separations in your file.

Note:  If you have chosen to use the curves saved in your input file (see Use press curves from
file in the Imaging Engine documentation), your PressSync curve will only be applied to the
separations that don't have a curve defined in the file.

Tip:

If you want to use different PressSync curves for different separations, you can use a
PressSync curve set instead.

Select Curve Strategy in Default Press Curve, then select your PressSync curve set in the list
at right.

7.2.  Using PressSync Curves in Nexus

To use PressSync curves when ripping a job with Nexus, enter them in the Assemble Separation
activity.

1. Click the Change Symphony Control button at the bottom of the dialog.
2. In the Symphony tab of the pop-up that opens:

a) choose PressSync in the Press list,
b) select the letter (in Series) and number (in Value) of the PressSync curve to use for most of your

inks,
c) click OK.
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3. You can now see a PressSync column in the Assemble Separation dialog. Adjust the PressSync

curves of the other inks.
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7.3.  Using a PressSync Curve Set in FlexRip

To use your PressSync curve set when ripping a job with FlexRip, select it in your RIP ticket in the
Automation Engine Pilot.

• In the Dot Gain Compensation area of the RIP ticket, select your PressSync curve set (.prsync) in
the Automatic list.
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7.4.  Using PressSync Curve Sets in a Strategy

A strategy (.icpro file) is a combination of various curves, which allows you to compensate different
cases (different inks, screen rulings, dots, etc.) in a different way.

A strategy can use DGC curves or/and PressSync curve sets. Each curve or curve set is linked to a
specific case (for example: round dots + 120 lpi + linework).

For more information about strategies, see the IntelliCurve manual.

Note:  You can only create strategies in Curve Pilot, not PressSync Pilot.

To use PressSync curve sets in a strategy:
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1. Go to File > New > Strategy (.icpro).
2. Build your strategy: use the buttons at right to create splits for different cases (per ruling/dot/

angle/...).
See the IntelliCurve manual for more information.

Note:  You shouldn't create splits based on inks as PressSync curve sets already perform
ink-based compensation.

3. For each case needing a PressSync curve set:
a)

click the DGC button  and choose  to use a PressSync curve set,
b) click the <none> column in the middle and select the PressSync curve set to use in the list.
You can see the curves of the selected curve set at the bottom of the strategy editor.
 

 

Note:  If you want, you can click Open... to open the selected curve set (to check or edit it).
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4. Save your strategy under a meaningful name.
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8.  Viewing Curve Sets in the Preview
Combined Curves Tool

The Preview Combined Curves tool is useful when working with curve sets and/or strategies. It lets
you check which curve of the curve set/strategy will be used in a specific case (ink, ruling, dot...).

It can also simulate what happens when using a combination of curves, for example plate
compensation together with press compensation.

8.1.  Previewing a PressSync Curve in a Curve Set

1. Go to Tools > Preview Combined Curves...
2. Depending on where you will use your PressSync curve set, select it either in the Automatic Press

or the Automatic Plate Making list.
3. In the Context area, select the ink whose compensation curve you want to preview:

a) in Ink Group, select the ink book containing your ink,
b) select your ink in Ink Name.

4. In the Curves area, you will see the name of the PressSync curve that will be used for your ink.
You will also see the curve drawn on the graph.
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8.2.  Previewing a PressSync Curve Set in a Strategy

1. Go to Tools > Preview Combined Curves...
2. Depending on where you will use your strategy, select it either in the Automatic Press or the

Automatic Plate Making list.
3. In the Context area, define the case you are interested in:

a) Select either Images (CT) or Linework (LW).
b) Select the ink book containing your ink in Ink Group, and the ink in Ink Name.
c) Select the Dot Shape, Ruling and Angle you are interested in.
If some of those criteria are not relevant for your case, your don't need to fill them in.

4. In the Curves area, you will see the name of the PressSync curve that will be used in the case you
defined.
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You will see the curve drawn on the graph.
 

 

8.3.  Previewing a Combination of Curves

You can also use the Preview Combined Curves to see the compensation that will be applied when
using both press and plate curves.

1. Go to Tools > Preview Combined Curves...
2. Select the compensation to use:

• for your press in the Automatic Press list,
• for your plate in the Automatic Plate Making list.

You can select .icpro strategies, .prsync curve sets or legacy .scrdgc screen-based DGC
files.
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3. In the Context area, define the case you are interested in:
a) Select either Images (CT) or Linework (LW).
b) Select the ink book containing your ink in Ink Group, and the ink in Ink Name.
c) Select the Dot Shape, Ruling and Angle you are interested in.
If some of those criteria are not relevant for your case, your don't need to fill them in.

4. In the Curves area, you will see the curves used both on the press and the plate for the case you
defined.
On the graph, you will see a curve that is a combination of those two curves.
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9.  Predefined Curve Sets for Printing
Standards

Curve Pilot comes with a number of predefined curve sets that you can use to help you match ISO or
GRACol printing standards.

• PressSync Templates Based on the ISO 12647 Standards

• PressSync Templates Based on the G7 Calibration Method
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https://docs.esko.com/docs/en-us/curvepilot/21.07/userguide/home.html#en-us/common/cup/reference/re_cup_cmykPressSync.html
https://docs.esko.com/docs/en-us/curvepilot/21.07/userguide/home.html#en-us/common/cup/reference/re_cup_3ckPressSync.html
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